INTRODUCTION
The State of Washington Secure Email Portal (Secure Email Portal) is a secure way to compose,
receive, view, reply to and forward encrypted messages over the Internet.
Messages are encrypted individually for each recipient and include a certified time stamp. These security
measures ensure that no one except the intended recipient can read the message. Because every
message is digitally signed, the recipient has irrefutable proof of the sender's identity.
Messages are stored securely until they expire.

OVERVIEW OF FEATURES
After you have successfully registered and activated your password, you are ready to navigate the
Secure Email Portal using the tabs at the top of the page.
The Inbox tab lists all of the unexpired, encrypted email messages that you have received. From the
Inbox, you can view the details of each message by selecting the Subject. Once the message details
display, you have additional options.
The Address tab allows you to add and manage email addresses of people you correspond with,
add and manage groups of contacts and send messages to them directly from this page.
The Compose tab allows you to initiate messages.
You can attach files, save a draft to complete later and send messages from this tab.
The Drafts tab displays incomplete messages that have not yet been sent. Messages saved
while composing, replying to or forwarding an email message are saved here as well as email
messages automatically saved as a draft when your session times out.
The ? icon directs users to this guide.
The Sign Out button allows you to exit the Secure Email Portal.

REGISTERING
The first time you receive a secure email, you will need to register your email account with the Secure
Email Portal system. Registration is a one-time, quick and easy process.
1. Select the Open Message button in the email message.
NOTE: If your email program does not support active links, cut and paste the link provided in the
message into your browser.
The Register Account page automatically displays your Email Address.
2. Type a Password that complies with the standards established by Washington state policy. See
the next section for more help with password creation.
3. Re-enter your password.
5. Select Register.
The Secure Email Portal opens and displays your email message. You now have access to the
Secure Email Portal.

ESTABLISHING A PASSWORD
Washington’s IT security policy establishes password guidelines to ensure the integrity and privacy of
information shared through its systems, networks and applications.
Create a password following these parameters:
Be 10 or more characters long and contain each of the following character classes: uppercase
letters, lowercase letters, numerals, special characters.
Not contain the user’s name, UserID or any form of their full name.
Not consist of a single complete dictionary word, but can include a passphrase.
Be significantly different from the previous four passwords. Passwords that increment
(Password1, Password2, Password3 ...) are not considered significantly different.

The Secure Email Portal supports the following special characters: ~, !, @, #, $, %, ^,&. Note the asterisk
and period are not valid special characters.
Password examples for Felix Hernandez with user name fhernandez and email address felixhernandez@isp.com:
Bad: Hernandez1 (includes user name)
Bad: baseball34 (includes single complete dictionary word)
Bad: fhernandez* (is user id and includes an unsupported character)
Good: MsA11st^rplyr (11 characters comprised of upper and lower case letters, supported character and
numbers, and isn’t a dictionary word or part of the user id, email or user name)
Passwords expire 180 days after being set. Reset or new passwords need to be different from the prior
password.
Bad: MsA11st^rplyr1 (simply adding a number to the end of the prior password)
Good: G~beyeB@sb@11 (brand new and meets requirements)

ACTIVATING YOUR PASSWORD
You must activate your password if you change it at any time. After changing your password:
1. Go to your regular email inbox and find the new email message with "State of Washington
Notification" in the Subject.
2. Open the email, which contains two links:
ACTIVATE your new password.
DECLINE your new password.
3. To activate your password, select the ACTIVATE link.
NOTE: If your email program does not support active links, copy and paste the link into the

Address field of your Internet browser and press ENTER.
The Activation Successful page opens.
4. Select Continue.
The Sign In page displays.
You can now sign in and have access to the Secure Email Portal.

SIGNING IN
To sign in from the Welcome page:
1. Enter your registered Email Address.
3. Enter your Password.
5. Select Sign In.

CHANGING YOUR PASSWORD
Reset Password allows you to change your password at any time. To change your password:
1. From the Welcome page, locate Forgot your password? and select the Reset Password
button. The Reset Password page displays.
2. On the Reset Password page, enter your Email Address.
3. Enter a Password that complies with Washington’s secure password guidelines.
4. Re-enter your new password.
5. Select Reset Password.
You will receive a confirmation email in your regular email Inbox with instructions on how to
activate your new password.

READING AND SENDING NEW MESSAGES
When a new secure message arrives in the Secure Email Portal, you receive a notification email in your
regular email inbox (associated with your registration email address). To read the message:
1. Open the notification email message in your inbox and select the hyperlink or Open Message
button. Sign in with your password.
From here, you may be able to:
Reply to, delete or forward the message.
Open or save the attachments, if the message has an attachment.
Save the email message as a text file.
Save the email message and attachment as a .zip file.
Go to the Secure Email Portal inbox.

COMPOSING MESSAGES
The Compose tab gives you the ability send secure messages to multiple email recipients.
To compose a new message:
1. Select the Compose tab.
You are taken to the Compose tab where a blank email message displays.
2. Enter one or more email addresses, separated by a comma or semi-colon, in the To field.
In some cases, you can select the recipients from a drop-down list.
3. If you would like to send a copy of this email message, enter one or more email addresses in the
Cc field.
4. Enter a description for your message in the Subject field.
5. Type your email message in the text box.
Select Attach File to attach files to your message before sending it.
Select Save Draft to save this message to the Drafts tab and send it later.
Note: Before the session times out, your email message will be automatically saved as a
draft message in the Drafts folder.
Use the formatting toolbar to customize your message text.
6. Select Send to send your completed message.
Note: The Secure Email Portal does not store sent messages. If you need to retain a copy of the
email, include your email address in the To or Cc fields.

REPLYING TO MESSAGES
You can reply to messages that you receive in your Secure Email Portal Inbox.
You have the option of replying to just the person who sent the message to you using the Reply button or
replying to the sender as well as any other recipients using the Reply All button.
To reply to a message:
1. From an open message, select the Reply or Reply All button.
Note: The Reply and Reply All functions do not allow a user to add recipients. If you need to
include additional message recipients, use the Forward feature.
You are taken to the Compose tab where the message displays in Reply mode. The To and
Subject fields are completed for you and the original message text displays.
NOTE: You cannot enter additional recipients or change the Subject text of a Reply or Reply All
email message.
2. Type your response text below the Attachments field.
Select Attach File to attach files to your reply before sending it.

Select Save Draft to save this message reply to the Drafts tab and send it later.
Note: Before the session times out, your email message will be automatically saved as a
draft message in the Drafts folder.
Use the formatting toolbar to customize your message text.
Note: formatting can only be applied to messages originally sent to you in HTML.
3. Select Send to send your completed reply message.

FORWARDING MESSAGES
You can forward most messages that you receive in your Secure Email Portal Inbox to other recipients.
To forward a message:
1. From any open message, select Forward.
2. Enter one or more email addresses, separated by a comma or semi-colon, in the To field. or
select the recipient from the drop-down list.
3. If you would like to send a copy of this email message, enter one or more email addresses in the
Cc field.
4. Type your message text.
5. Select Send to forward the completed message.

USING THE FORMATTING TOOLBAR
When replying to, forwarding or composing a message, use the formatting toolbar to format the text of
your message.
Note: formatting can only be applied to messages originally sent to you in HTML or new messages that
you compose.
Select on the different parts of the picture below to see the function of each item:

ATTACHING FILES TO A MESSAGE
While composing, replying to or forwarding a message, you can attach one or more files to be sent with
the message. The number of files you can attach and the total size of these files are listed on the Attach
File page.
To attach a file to a message you are composing:
1. Select Attach File at the top of the message.
The Attach File page displays.
2. Select Browse.
TIP: You can also type the path to the file.
The File Upload dialog displays.

3. Select the file you want to attach by navigating to the folder and highlighting the file name.
4. Select Open.
The file name appears in the box next to the Browse button.
5. Select Add File.
The file name appears in the Attachments field.
6. Repeat the steps above until all files are attached.
7. Select Finish.
You are returned to the previous page with the files attached.
Note: To verify that all of your files are attached, select the arrow next to the Attachments dropdown field. All of the attached files are listed.

REMOVING ATTACHMENTS FROM A MESSAGE
To remove an attachment from a message you are composing:
1. Select Update Attachments at the top of the message.
The Attach File page displays with your files listed in the Attachments field.
2. Select the file you want to remove by selecting it in the Attachments field.
3. Select Remove File.
4. Select Finish.
You are returned to the previous page without the attachments you removed.
TIP: You can also remove a file while composing your message by selecting it from the
Attachments drop-down list and selecting Remove File.

OPENING AND SAVING ATTACHMENTS
You can open and save attachments that you receive in the Secure Email Portal. To open or save a file
attached to an email message, once in the open message, select the file name of the attachment you
want to view and then follow the Internet browser instructions.
NOTES:
If you do not have the program required to open the file, you can save it, but cannot view it.
The file size affects the speed at which you download the file. The larger the file, the longer it
takes to download it.

ADDING CONTACTS TO YOUR ADDRESS BOOK
You can enter and save contact information for those with whom you correspond regularly and then use
that saved information to send email messages to each contact.
To add a contact to your Address book:

1. Select the Address tab.
The Address page displays.
2. Select Add Contact.
The Add Contact page displays.
3. Enter the Contact information:
First Name
Last Name
Email Address
4. Select Save to save the contact information.

ADDING GROUPS TO YOUR ADDRESS BOOK
You can organize your contacts into groups and then send an email message to all the group members.
To add a group to your Address book:
1. Select the Address tab.
The Address page displays.
NOTE: Be sure that all contact members of the group have already been added to your Address
book.
2. Select Add Group.
The Add a Group page displays.
3. Type a unique, meaningful name for the group in the Group Name field.
4. Select one or more contacts from the Available Contacts list.
5. Select Include.
The contact names are moved to the Contacts in Group list.
Note: To remove a contact from the group, you can select the contact name in the Contacts in
Group list and select Remove.
6. Select Save.
The Address page displays with your new group in the list.
TIP: Select the plus (+) sign to see the contacts included in each group.

SAVING A MESSAGE AS A DRAFT
You can save a message that has not yet been sent as a draft that you can send later.
To save a message as a draft:
1. While composing, replying to or forwarding a message, select Save Draft at the top of the
message.
2. You are taken to the Drafts tab where your message has been saved.
3. When you want to complete the message, select the Drafts tab.
A list of your unsent draft messages displays showing the message subject and the date it was
saved.

4. Select a message by selecting the Subject link.
The message displays in the Compose tab for you to complete and send.
5. Complete the message and select Send.
After a draft is sent, it is moved from the Drafts tab to the Sent Mail tab.
Additionally, when composing, replying to or forwarding an email message, just before your portal session
times out, your message will be automatically saved as a draft message in the Drafts folder. When this
happens, you are redirected to the Drafts page and a notification message stating “Your email message
was automatically saved as a draft” displays.

SAVING A MESSAGE AS A TEXT FILE
You can save messages that you have received to or sent a copy to yourself from the Secure Email
Portal as a text file. You can then keep a copy of the message, even after it expires and has been
removed from your Inbox.
NOTE: When saving a message as a text file, the UTF-8 character set is used. UTF-8 is a common used
character set encoding that enables messages in different languages to be saved in a text file.
To save a message as a text file:
1. From the Inbox or Sent Mail tab, select the Subject link to open the message that you want to
save.
2. Select the arrow next to the More Actions drop-down field.
4. Select Save message as a text file.
Select Go.
5. Follow the Internet browser instructions to save the file to a location you specify.

SAVING MESSAGES AND ATTACHMENTS
You can save messages with attachments that you have received to or sent a copy to yourself from the
Secure Email Portal as a .zip file. You can then keep a copy of the message and attachment, even after
it expires and has been removed from your Inbox.
To save a message and its attachment:
1. From the Inbox or Sent Mail tab, select the Subject link to open the message that you want to
save.
2. Select the arrow next to the More Actions drop-down field.
3. Select Save email message and attachments as a .zip file.
4. Select Go.
Follow the Internet browser instructions to save the .zip file to a location you specify.

PRINTING
You can print any message in the Secure Email Portal as you would any web page.

To print a message or any other page, from your Internet browser, select File > Print. Follow the
instructions on the screen to select a printer and print the message. For more information on printing
Internet browser pages, see your Internet Browser application's Help.

DELETING MESSAGES
Messages are automatically deleted from your Inbox tabs when they expire, but you can also delete them
before the expiration date.
To delete a message:
1. Select the Inbox or Drafts tab that contains the message you want to delete.
2. Select the check box next to each email message you want to delete.
TIP: You can select more than one message at a time to delete.
3. Select Delete.
The selected messages are deleted.
NOTE: To delete an open message, from an open message, select Delete.

MESSAGE EXPIRATION
Messages automatically expire after 30 days. The message expiration date displays in the details of each
email message you receive. If you want to keep a copy of the message after its expiration date, you can
print it, save the message as a text file or save the message and any attachments as a .zip file.
Prior to the message expiration you may receive an email notification in your regular email Inbox with the
following information:
Date the message was sent
Date the message expires

FREQUENTLY ASKED QUESTIONS
How long will messages be kept in the Secure Email Portal?
Thirty days. The expiration of each message is displayed in the body of the notification message you
received.
How secure is the Secure Email Portal?
Messages stored in the Secure Email Portal are encrypted with 168-bit triple DES encryption. Messages
are viewed using secure Internet connections with high encryption. This level of encryption is considered
highly secure by industry standards.
What Internet browsers are recommended?
We recommend that you use one of the following:
®

®

Microsoft Internet Explorer version 7.0 or higher
®

®

Mozilla Firefox version 4.0 or higher

™

®

Apple Safari version 5.0 or higher
Other Internet browsers may be used, but have not been validated by Zix Corporation.
What mobile devices are recommended for use in reading messages in the Secure Email Portal?
We recommend that you use one of the following:
®

BlackBerry version 6.0 or higher
®

®

Apple iPhone and iPad
Android

®

®

version 4.3 or higher

devices 2.3 or higher

Other mobile devices may be used to view your messages, but have not been validated by ZixCorp.
How can I access the Secure Email Portal?
You can access the Secure Email Portal from a recommended mobile device or any computer with
access to the Internet.
What privacy or cookie settings are needed in my Internet browser?
Privacy settings must be set to medium, or lower and cookies must be enabled. See your Internet
browser help for more information on privacy settings.
What should I do if I receive an error message when I try to sign in?
If the error message is about your email address and/or password, make sure that you have entered
your Email Address and Password information correctly.
If you still cannot sign in, select the Forgot your password? Reset button on the Sign In page. On the
Reset Password page, enter your email address. Enter a Password that complies with the password
rules shown, Re-enter your new password and select Submit.
If the error message is about something other than your email address and/or password, contact
Washington State Consolidated Technology Services help desk: Servicedesk@cts.wa.gov; 888241-7597; TTY at 800-833-6388.
What do I do if I forget my password or want to change my password?
On the Welcome page, select the Reset Password button under “Forgot your password?” See the
instructions in Changing your Password for more information.
Can I send large file attachments?
The number of attachments is limited to 10, with a total combined size of 30 MB.
How can I change the size of the text of a message I’m viewing in my browser?
®

®

In Microsoft Internet Explorer , select the View dropdown menu, and use the Zoom option to
increase or decrease the size of the message text. A shortcut is using Ctrl + or – to resize the
font.
®

®

In Mozilla Firefox , to only zoom in on text on a page, select View >Zoom > Zoom Text Only.
Then use Ctrl + or – to resize the font only.
®

™

In Apple Safari , use Ctrl and the + or – to resize the text on your screen.
Can other people view my secure messages?
No, the Secure Email Portal servers receive the email messages securely and store them using 168bit, triple DES encryption. Intended recipients must use their password to open any email messages
they receive, therefore no one else can view your messages.
Can I get an expired message back once it is removed from my Inbox?
If the message has expired and been deleted, it is no longer available. Due to the security features of
the Secure Email Portal, the sender of the message must re-send it to you.
When a message expires, an expiration notification email message is returned to the sender.

You can still access the Secure Email Portal from an expired message notification in your regular
email Inbox, but will not be able to see the expired email message.
I’m not seeing the secure email you said you were going to send me. Where is it?
If a secure message notification hasn’t arrived in the recipient’s mailbox, the secure message
notification email may be blocked or quarantined by your anti-spam software. Please check your
quarantine server or work with your local email administrator or internet service provider. The secure
message notification email may have also been delivered to your “Junk” folder. If this is the case, you
can retrieve the message from the “Junk” folder and add the sendsecure.m86security.com to your
“safe sender list” so that any future notification will get routed to your Inbox. If you still can’t find the
secure message notification email, contact your IT department or internet service provider and have
them white list sendsecure.m86security.com, which is IP address 63.71.11.102 for inbound mail.
Please ask the message sender to resend the secure message.
What do I do if I need additional assistance?
For customer support, contact the Washington State Consolidated Technology Services (CTS) help
desk: 888-241-7597; TTY at 800-833-6388 or servicedesk@cts.wa.gov.

